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EVAL-6ED2231S12TM1 User Guide

1200 V SOl gate driver 6ED2231S12T evaluation board

About this document

Scope and purpose

This user guide provides an overview of the evaluation board EVAL-6ED2231S12TM1 including its main features,
key components, pin assignments, and mechanical dimensions. This guide also describes how to run a brushless
direct current (BLDC) motor.

EVAL-6ED2231S12TM1 is a power evaluation board that includes an M1 connector, one EasyPACK™ 1B 1200 V
CoolSiC™ MOSFET three-phase module, and one three-phase silicon-on-insulator (SOI) gate driver for motor
drive applications. In combination with either EVAL-M1-101T or other control board with compatible M1
connectors, the EVAL-6ED2231S12TM1 features and demonstrates Infineon’s CoolSiC™ MOSFET module and SOI
gate driver technology for motor drives.

EVAL-6ED2231S12TM1 was developed to support users during their first steps in designing applications with
Infineon’s EasyPACK™ 1B CoolSiC™ MOSFET module and the three-phase gate driver.

Intended audience

This document is intended for all technical specialists who have a knowledge of motor control and electronic
converters with several kilowatts of power. The board must be used only under laboratory conditions.

Evaluation board

EVAL-6ED2231S12TM1 is designed to evaluate the 1200 V SOI three-phase gate driver 6ED2231S12T along with
the EasyPACK™ 1B 1200 V CoolSiC™ MOSFET module FS55MR12W1M1H_B11.

This board will be used during design-in for evaluation and measurement of characteristics, and proof of data
sheet specifications.

Note: PCB and auxiliary circuits are NOT optimized for final customer design.

Ordering information

Base part number Package Standard pack Orderable part number
Form Quantity

EVAL-6ED2231S12TM1 MADK EVAL Boxed 1 EVAL6ED2231S12TM1TOBO1
6ED2231S12T PG-DS0O-24 Tape and Reel 1000 6ED2231S12TXUMA1
EVAL-M1-101T MADK EVAL Container 1 EVALM1101TTOBO2
FS55MR12W1M1H_B11 AG-EASY1BM Tray 24 FS55MR12W1M1HB11NPSAl
ICE5QSAG PG-DSO-8 Tape and Reel 2500 ICE5QSAGXUMA1
IMBF170R1KOM1 PG-TO263-7 Tape and Reel 1000 IMBF170R1KOM1XTMA1
IFX25001TF V33 PG-T0252-3 Tape and Reel 2500 IFX25001TFV33ATMA2
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Important notice

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board
(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration,
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).

Environmental conditions have been considered in the design of the Evaluation Boards and Reference
Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards
has been tested by Infineon Technologies only as described in this document. The design is not qualified
in terms of safety requirements, manufacturing and operation over the entire operating temperature
range or lifetime.

The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional
testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the
same procedures as regular products regarding returned material analysis (RMA), process change
notification (PCN) and product discontinuation (PD).

Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for
evaluation and testing purposes. In particular, they shall not be used for reliability testing or production.
The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards
(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other
requirements of the country in which they are operated by the customer. The customer shall ensure that
all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant
requirements and standards of the country in which they are operated.

The Evaluation Boards and Reference Boards as well as the information provided in this document are
addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and
managed according to the terms and conditions set forth in this document and in other related
documentation supplied with the respective Evaluation Board or Reference Board.

It is the responsibility of the customer’s technical departments to evaluate the suitability of the
Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness
and correctness of the information provided in this document with respect to such application.

The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not
cause any harm to persons or third party property.

The Evaluation Boards and Reference Boards and any information in this document is provided "as is"
and Infineon Technologies disclaims any warranties, express or implied, including but not limited to
warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or
for merchantability.

Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation
Boards and Reference Boards and/or from any information provided in this document. The customer is
obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or
damages arising out of or resulting from any use thereof.

Infineon Technologies reserves the right to modify this document and/or any information provided
herein at any time without further notice.
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Safety precautions
Note: Please note the following warnings regarding the hazards associated with development systems.

Table1l Safety precautions

Warning: The DC link potential of this board is up to 800 VDC. When measuring voltage
waveforms by oscilloscope, high voltage differential probes must be used. Failure to do
so may result in personal injury or death.

Warning: The evaluation or reference board contains DC bus capacitors which take
time to discharge after removal of the main supply. Before working on the drive
system, wait five minutes for capacitors to discharge to safe voltage levels. Failure to
do so may result in personal injury or death. Darkened display LEDs are not an
indication that capacitors have discharged to safe voltage levels.

Warning: The evaluation or reference board is connected to the grid input during
testing. Hence, high-voltage differential probes must be used when measuring voltage
waveforms by oscilloscope. Failure to do so may result in personal injury or death.
Darkened display LEDs are not an indication that capacitors have discharged to safe
voltage levels.

Warning: Remove or disconnect power from the drive before you disconnect or
reconnect wires, or perform maintenance work. Wait five minutes after removing
power to discharge the bus capacitors. Do not attempt to service the drive until the bus
capacitors have discharged to zero. Failure to do so may result in personal injury or
death.

Caution: The heat sink and device surfaces of the evaluation or reference board may
become hot during testing. Hence, necessary precautions are required while handling
the board. Failure to comply may cause injury.

Caution: Only personnel familiar with the drive, power electronics and associated
machinery should plan, install, commission and subsequently service the system.
Failure to comply may result in personal injury and/or equipment damage.

Caution: The evaluation or reference board contains parts and assemblies sensitive to
electrostatic discharge (ESD). Electrostatic control precautions are required when
installing, testing, servicing or repairing the assembly. Component damage may result
if ESD control procedures are not followed. If you are not familiar with electrostatic
control procedures, refer to the applicable ESD protection handbooks and guidelines.

Caution: A drive that is incorrectly applied or installed can lead to component damage
or reduction in product lifetime. Wiring or application errors such as undersizing the
motor, supplying an incorrect or inadequate AC supply, or excessive ambient
temperatures may result in system malfunction.

Caution: The evaluation or reference board is shipped with packing materials that
need to be removed prior to installation. Failure to remove all packing materials that
are unnecessary for system installation may result in overheating or abnormal
operating conditions.

>R B B BB
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1 The board at a glance

The evaluation board EVAL-6ED2231S12TM1 provides a DC input and a three-phase output for power motors. It
contains the gate driver IC 6ED2231S12T, the EasyPACK™ 1B module FS55MR12W1M1H_B11, a heat sink, bus
capacitors, a single shunt for current sensing, a voltage divider for DC-link voltage measurement, and other
peripheral circuits.

1.1 Delivery content

The EVAL-6ED2231S12TM1 evaluation board is delivered along with a daughter board (EVAL-6ED2231S12TM1D)
for the gate driver, and an iIMOTION™ 2.0 M1 interface connector.

The package also contains a quasi-resonant, pulse-width modulation (PWM) controller; a CoolSiC™ MOSFET-
based auxiliary power supply to provide 18 V and 3.3 V; a single shunt for current sensing and overcurrent
protection; and a voltage divider for DC-link voltage measurement. The board can be operated directly with the
required DC power supply without any additional components.

1.2 Block diagram

Figure 1 shows a typical application diagram of EVAL-6ED2231S12TM1 for driving a BLDC motor. The system
adopts a single-shunt configuration, which is prevalent for current BLDC motor drive applications.

EVAL-6ED2231S12TM1

!

Auxiliary
Power Supplies

EVAL-6ED2231S12TM1D

> > > T
> > ;

-»_ input

Daughter board

Figure 1 Typical application block diagram of EVAL-6ED2231S12TM1

The functional blocks of EVAL-6ED2231S12TM1 are presented in Figure 2 and Figure 3.
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Figure 2 Functional blocks of EVAL-6ED2231S12TM1 (top view)
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Figure3  Functional blocks of EVAL-6ED2231S12TM1 (bottom view)
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1.3 Main features

The main features of EVAL-6ED2231S12TM1 include:

e Nominal DCinput voltage of 510 V

e Design for maximum 5 kW motor power output

¢ Single shunt for current sensing

e Sensing of DC-link voltage

e Internal negative temperature coefficient (NTC) thermistor for overtemperature protection
e +18Vand +3.3Vauxiliary power supplies on the board

e Ml interface compatible with the iMOTION™ control board

1.4 Board parameters and technical data

The key specifications of EVAL-6ED2231S12TM1 are listed in Table 2.

Table 2 Specifications of EVAL-6ED2231S12TM1

. Value Unit

Parameter Symbol | Conditions ;
Min. | Nom. | Max.

Input
Input voltage Vin DC voltage 120 | 510 | 720 |V
Input current Iin Input current - - 10 |A
Output
Output current lout RMS phaseout current - - 15 |A

Additional heat dissipation is needed

Output power Paur (e.g. forced air cooling) - - > kW

Overcurrent protection locp Peak phaseout current - - 25.2 |A
Thermal protection

NTC overtemperature ] o ) 1.09 | 2.75 - Vv

threshold VTH Configuration in MCEWizard 100 o - o

Switching frequency

requeny | Fo - .| -
Auxiliary power supply
Gate driver power supply Vee - 18 - v
Controller power supply - 33 - v
System environment
Ambient temperature ‘ ‘ With adequate cooling method ‘ - ‘ 25 ‘ - °C
PCB characteristics
L Length - 130 - mm
Dimensions W Width - 120 - mm
H Height - 60 - mm
Layer - 2 -
User guide 70of33 V1.1
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. Value Unit
Parameter Symbol | Conditions .
Min. ‘ Nom.‘ Max.
Input
PCB thickness - 1.6 - mm
Copper thickness - 1 - oz.
Weight Weight of the entire PCB assembly - 1000 - g
Material FR-4, RoHS-compliant
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2 System and functional description

2.1 Getting started with EVAL-6ED2231S12TM1

To run the motor system, a combination of the iIMOTION™ power board EVAL-6ED2231S12TM1 and a matching
iMOTION™ control board (e.g. EVAL-M1-101T) are required. This chapter explains how to set up the system and
get started with the IMOTION™ development platform.

The power board EVAL-6ED2231S12TM1 can run a BLDC motor by connecting to the iMOTION™2.0 control board
EVAL-M1-101T through an M1 interface. The system connection is shown in Figure 4, and the test results are listed
in section 4.1.

DCinput

a
- m; ics

= ] RIDER -=mz
w wm: Dp2e  wme D3w e

EVAL-M1-101T

C3MN] csjuN] csMEN
e S Sy

4

(]
R13W = R14 Ris! =lR17
- e

X15 A\xse xm_&xn

U/V/W phase-out

(nfineon "'

EVAL-6ED2231S12TM1
REV 1.0
2022-03-16

Figure 4 The system connection for running a BLDC motor

2.1.1 The iMOTION™ control board

You can order the Infineon control board EVAL-M1-101T from https://www.infineon.com/cms/en/product/

evaluation-boards/eval-m1-101t and download the latest IMC101T-T038 MCE Software Package from

www.infineon.com/imotion-software.

After obtaining EVAL-M1-101T and the latest software, connect your PC to the control board via a USB cable to

program and tune it.

1. Connect EVAL-M1-101T’s M1 20-pin interface connector J2 to the daughter board X8.

2. In the MCEWizard enter the system and operating parameters of the target motor and the hardware
parameters of the evaluation board. This data is used for calculating the digital parameter set of the
controller, representing the complete motor drive system.

User guide 90f33 V1.1
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3. Go to the Verify & Save page and click Calculate Parameters. Then, save the drive parameter set into your
project directory by clicking Export to MCEDesigner file (.txt) (see Figure 6). This saved drive system
parameter file will be used later by the MCEDesigner. Refer to Section 2.1.4 or the MCEWizard user guide for
more information.

Connect motor phase outputs (X9 on the mother board) to the motor.

Connect DC power to the power input connector (X8 on the mother board), then power on the system.
Start the MCEDesigner tool.

Click File > Open to open the MCEDesigner default configuration file (.irc) for the IMC101T-T038 controller
(IMC101T_Vxxx.irc). The IMC101T_Vxxx.irc file is included in the IMC101T-T038 MCE software package.

8. The MCEDesigner should automatically connect to the EVAL-M1-101T control board using the default COM
port (indicated by a green circle next to the “COMx Up” status in the bottom frame of the MCEDesigner GUI).
If the connection cannot be established, change the COM port:

a) Open the System Page window.
b) Click Preferences > Connection > Connect using.
c) Choose one of the other available COM ports from the drop-down list.
Program the system parameters into the internal SRAM of the iIMOTION™ IC using the following steps:
a. Click Tools > Programmer and select Program Parameters.
b. Browse and select the System Drive Parameters file created in step 3. See Section 2.1.4 for more
information.
10. Start the motor by clicking the green traffic light button in the control bar. To stop the motor click the red
traffic light button in the control bar.

No ok

©

2.1.2 iMOTION™ development tools and software

The EVAL-6ED2231S12TM1 evaluation board can run a BLDC motor when connected to an external control board
EVAL-M1-101T. Users must configure the IMOTION™ development tool and software according to the system and
BLDC motor parameters.

The MCEDesigner, MCEWizard, and supported files can be downloaded from http://www.infineon.com/
imotion-software.

2.1.3 MCEWizard setup overview

Use the MCEWizard to configure the parameters for the evaluation board or motor. Figure 5 shows the Welcome
page of the MCEWizard. Here, users can select the control board or power board from a drop-down list. Infineon
releases new control and power boards regularly. Therefore, it is possible that some of the latest power boards
have not been pre-configured in the MCEWizard tool and cannot be selected from the drop-down menu. In that
case, users can select another (as similar as possible) power board and follow the setup steps in the MCEWizard
by entering parameters specific to the power board chosen. Please refer to the application note of the
corresponding power board for additional information.

After selecting the modular application design kit (MADK) control board and the power board, click Next in the
right-hand bottom corner of the Welcome page to start the MCEWizard system setup process.
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File JumptoPage Help

Welcome Page

Using System Configuration File:
EVAL-M1-101T-05-65D.mc2

This motor control system is an
evaluation kit for complete inverter-
controlled motor drive applications
based on EVAL-M1-101T iMOTION
MADK controler board (based on
IMC101T-T038 iMOTION controller)
and EVAL-M1-05-65D MADK inverter
board (based on IRSM505-065DA2
CIPOS Micro IPM).

Following two options are available.

If no hardware change is done on this
board and there is no plan to change
default control settings:

Select > Default Hardware and Control
Settings.

Open System Configuration File

Q MCEWizard 2.3.0.1 - C:/Users/wchu1/WDC/IPC/ISD/IPM/imotion/iMotion 2/SiC board/Golden age motor.mc2 =

iMOTION™ 2.0 System Configuration Wizard

Infineon
-

Get MADK Hardware Info Get iMOTION™ Info

Save System Configuration File

Previous

Next

Figure5 Welcome page of the MCEWizard

The iIMOTION™ system enables users to easily test different combinations of control and power boards with their
motors. Users should be familiar with system-level parameters related to the motor used. There are a limited
number of parameters specific to the control board or power board hardware. Table 3 lists the hardware
parameters specific to EVAL-6ED2231S12TM1 power board for MCEWizard setup. Similar tables are available for
each control board in its application note. A combination of data in this table and the corresponding table of the
control board provides sufficient information to quickly set up the motor drive system.

Table3 MCEWizard setup overview table

Parameter Value

Control board selecting EVAL-M1-101T for example
Motor 1 shunt configuration Single shunt

Controller supply voltage +3.3V

Max DC bus voltage 720V

DC bus sensing high resistor 4000 kQ

DC bus sensing low resistor 13kQ

NTC temperature shutdown value

Refer to the control board’s application note

Gate sense low-side devices

Highis true

Gate sense high-side devices

High is true

Motor 1 current input scaling

control board’s application note

Calculated in the corresponding section of the

After all the MCEWizard questions are answered, the Verify & Save Page opens (see Figure 6.)
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n MCEWizard 2.3.0.1 - C/Usersfwchul/Desktop/EVAL-M1-101T-IM818-A.mc2 - x

File JumptoPage Help
Verify & Save Page -

Verify Parameters
Calculate Parameters |Display Parameters Results| Export to MCEDesigner File (.bx)

Double-Click an item to JUMP to its associated question

Previous Next

Figure6 Verify and save page of the MCEWizard

Click Calculate Parameters and then Export to MCEDesigner File (.txt) to save the parameter file. This file will
be used by the MCEDesigner in the next steps.

2.1.4 MCEDesigner setup overview

The MCEDesigner is a user interface to access or debug the control board. Open the MCEDesigner and then open
the IMC101T_xx.irc file. The main display page for EVAL-M1-101T opens, as shown in Figure 7.

1B System - IMC101T_V1.03.03.rc - MCEDesigner Ver 2.3.0.1 - Infineon Technologies - o x
File View Preferences Tools Window Help
=5 & 8 ®
23
. C 2\SIC board s

= Bl Monitor Definitions
= B Fluxtangle & Motarspeed
= B MotorSpeed ATargetSpeed
i B u & e_Fast
= Bu& e Slow
= B M
B P Q B P
& B lu & MotorSpeed
= Buatg
=B Stats & 5pd /Trg
= B statis & b
- B Flungle & SpdErr
w Bid&lg

o B FhcA & Pl d
- Bvdave
& B idRet &l
< >

{3 Motor? - IMCI0TT_V103.03.irc =22

= B Emergency Stop
= B Configure Motor

- B Clear Fauits
- B VF Diagnastic
B Read DC Voltage Count
=B Cument Loop Tune
& B Speed Loop Tune
- B Change Target Speed
- = Curtent Feedback Tune Based on Hardw

< >

For Help, press FI IMCIT COMS Down | Trig Idle & Mator! Inact) & Systern Inactive
P Type here to search

Figure7  MCEDesigner’s main display for EVAL-M1-101T
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After the drive system parameter file has been programmed into the IMC101 controller and the motor drive
system powered, the MCEDesigner can be used to start/stop the motor, display motor current traces, change the
motor speed, modify drive parameters, and perform many other functions. Please refer to the MCEDesigner
documentation for more details.

2.2 Description of functional blocks

The motor inverter in EVAL-6ED2231S12TM1 hardware design is implemented by a 1200 V SOI three-phase gate
driver 6ED2231S12T and the EasyPACK™1B 1200 V CoolSiC™ MOSFET module FS55MR12W1M1H_B11. The
auxiliary power supply is based on the quasi-resonant controller ICE5QSAG and CoolSiC™ MOSFET
IMBF170R1KOM1.

2.2.1 Overview of 6ED2231S12T

Figure 8 shows the functional block diagram of 6ED2231S12T. For more information such as static and dynamic
electrical characteristics of the gate driver, please refer to the datasheet of 6ED2231S12T.
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Figure 8 Functional block diagram of 6ED2231S12T
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The main features of 6ED2231S12T include:

e Infineon’s thin-film SOI technology

e Fully operational up to +1200V

e Integrated ultra-fast bootstrap diode

e Floating channel designed for bootstrap operation

e Output source/sink current capability of +0.35 A/-0.65 A

e Tolerant to negative transient voltage up to -100 V (pulse width up to 700 nanoseconds) provided by the
SOl technology

e Undervoltage lockout for both channels

e Compatible with3.3V,5V, and 15V input logic

e Overcurrent protection with £5% ITRIP threshold

e Fault reporting, automatic fault clear, and enable functions on the same pin (RFE)

e Matched propagation delay for all channels

e Integrated 460 nanoseconds of dead time

e Shoot-through (cross-conduction) protection

Table 4 Absolute maximum ratings of 6ED2231S12T

Symbol Definition Min. Max. Units
Vee Low-side supply voltage -0.3 25

Vi Logic input voltage (LIN, HIN, RFE, ITRIP) Vss-5 Vee+0.3

Ve123 High-side floating well supply voltage -0.3 1225

Vsi23 High-side floating well supply return voltage Vei123 - 25 Vei123+0.3 v
Vo123 Floating gate drive output voltage Vsi123-0.3 Ve123+0.3

Vio123 Low-side output voltage -0.3 Vec+ 0.3

Vss Logic ground Vee-25 Vec+ 0.3

dVs/dt Allowable Vs offset supply transient relative to COM — 50 V/ns
Po Package power dissipation @ T, <+25°C — 1.3 W
Rthja Thermal resistance, junction to ambient — 75 °C/W
T, Junction temperature — 150

Ts Storage temperature -55 150 °C

TL Lead temperature (soldering, 10 seconds) — 300
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2.2.2 Overview of FS55MR12W1M1H_B11

The FS55MR12W1M1H_B11 is an EasyPACK™ 1B 1200 V / 52.9 mQ (typical) six-pack module with CoolSiC™
MOSFET, NTC, and PressFIT contact technology.

Figure 9 shows the circuit diagram of FS55MR12W1M1H_B11. For more information about the module, please
refer to the datasheet of FS55MR12W1M1H_B11.

DC+o o D(+
- =
G1 G3 G5 X107y,
S1 I S3 v S5 W .
X2
G2 G4 G6
S? Sk S6
DC-1 DC-2 DC-3
Figure 9 Circuit diagram

The main features of FS55MR12W1M1H_B11 include:

o High current density

e Best-in-class switching and conduction losses
e Low inductive design

e Integrated NTC temperature sensor

e PressFIT contact technology

e RoHS-compliant modules
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2.2.3 Overview of ICE5QSAG

The latest, 5" generation quasi-resonant fly-back pulse width modulation (PWM) controller ICE5QSAG offers high
performance and comprehensive suite of protection to increase system robustness.

Figure 10 shows the functional block diagram of ICE5QSAG. For more information regarding the PWM controller,
please refer to the datasheet of ICE5QSAG.
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Figure 10 Circuit diagram

The main features of ICESQSAG include:

e Novel quasi-resonant operation and proprietary implementation for low EMI

e Enhanced active burst mode with selectable entry and exit standby power

e Active burst mode to reach the lowest standby power

e Fast startup achieved through cascade configuration

o Digital frequency reduction for better overall system efficiency

e Robust line protection with input overvoltage protection and brownout protection
e Comprehensive protection

e Lead-free plating, halogen free mold compound, RoHS compliant
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2.2.4 Overview of IMBF170R1KOM1

IMBF170R1KOML1 is a CoolSiC™ 1700V, 1000 mQ SiC MOSFET in a TO-263-7 high creepage package; optimized for
fly-back topologies. It can be used in auxiliary power supplies connected to DC-link voltages from 600 V up to
1000 V in numerous power applications. For more information regarding the power device, please refer to the
datasheet of IMBF170R1KOM1.

The main features of IMBF170R1KOM1 include:

e Revolutionary semiconductor material—silicon carbide

e Optimized for fly-back topologies

e 12V/0V gate-source voltage compatible with most fly-back controllers
e Very low switching losses

e Benchmark gate threshold voltage, Vesin = 4.5V

e Fully controllable dV/dt for EMI optimization
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3 System design
This chapter covers the hardware design of EVAL-6ED2231S12TM1 in detail. Users can modify the circuit or re-
select the component values based on actual applications in the field.

3.1.1 DC-link voltage measurement

Bus capacitors should be large enough to stabilize the bus voltage. The resistors R1 and R3 are used to balance
the voltage on the electrolytic capacitors in series as shown in Figure 11.

Note: The resistor R11 is soldered on the mother board of EVAL-6ED2231S12TM1. Therefore, the 13.3 kQ pull-down
resistor located on the EVAL-M1-101T control board must be removed.

X8 DC+
]2
211
- 1 jiCl
. MEGT 470uF 2
Power input ~ MEG
_l.c
~T470nF
+C3 [:E4
MEﬂ—MOuF MEG
5
MEG
8
MEG
VDC
11
3k
VSS
Figure 11 Bus capacitor configuration and DC bus sensing

3.1.2 Inverter section using FS55MR12W1M1H_B11

The inverter section is implemented using FS55MR12W1M1H_B11 as shown in Figure 12. It is a three-phase
inverter bridge section with Infineon’s CoolSiC™ SiC MOSFET. R15/R16/R17 (in parallel) are single shunt for
current sensing.
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Figure 12 The diagram of the inverter section

3.1.3 Drive circuit with 6ED2231S12T

Adedicated daughter board for the three-phase gate driver 6ED2231S12T is mounted on top of the mother board
to drive the SiC module. The configuration of 6ED2231S12T is shown in Figure 13.

Three capacitors C3, C4, and C5 are used as bootstrap capacitors to provide necessary floating supply voltages
VBS1, VBS2, and VBS3 respectively. Thanks to the three-bootstrap diode integration in 6ED2231S12T, external
bootstrap diodes are not needed.

6ED2231S12T (high voltage integrated circuit) HVIC is equipped with ITRIP input pins. This functionality can be
used to detect overcurrent events in the DC bus. When the HVIC detects an overcurrent event through the ITRIP
pin, the output is shut down and the RFE is pulled to VSS to report the fault condition. The RFE can also be used
as the enable input pin and fault-clear time programmable pin. The fault-clear time setup is based on the
datasheet of 6ED2231S12T.

The main feature of 6ED2231S12T designed on Infineon’s C5S0I technology is its tolerance towards negative
transient voltage in inductive load applications. 6ED2231S12T can tolerate repetitive negative transient voltage
of up to 100 V (pulse width up to 700 nanoseconds).
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Figure 13 Drive circuit design with 6ED2231S12T

3.1.4 Overcurrent protection

The overcurrent circuit is shown in Figure 12. To save power loss of the shunt resistor, the Rqwunt value is set as 10
mQ by using three 30 mQ / 3 W surface-mount device (SMD) resistors (R15/R16/R17) and low equivalent series
inductance (ESL) in parallel. In the design, the target current for overcurrent protection (loce) is 25 A. The
overcurrent threshold of the ITRIP pin is 0.5 V. An additional 0.25 V DC-bias voltage is needed at the ITRIP pin to
meet the target current of 25 A. This is achieved by using resistor dividers R19 and R20 with 3.3V supply.

The locp is calculated using:

R19
Virrip+ — RO+ R20 " 3.3V) * (R19 + R20)

R20 * Rshunt
=2524

Tocp =

Here, Virrie+ is the positive going threshold for ITRIP and its typical value is 0.5V, R19 =1 kQ, and R20 = 11.3 kQ.

3.1.5 NTC thermistor configuration

FS55MR12W1M1H_B11 includes a NTC thermistor. Its temperature curve is shown in Figure 14. The resistance of
the NTC thermistor is 5 kQ at 25°C and 493 Q at 100°C.
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Figure14 Typical temperature characteristic of the NTC thermistor

A1KkQ pull-up resistor is already located on the daughter board. As shown in the NTC thermistor configuration in
Figure 15, the sensing voltage VTH equals 2.75 V at 25°C and 1.09 V at 100°C. In the MCEWizard, the
overtemperature voltage threshold of the NTC thermistor is set to 1.09 V to protect the SiC module.

Note: If EVAL-M1-101T is used as the control board, the 4.87 kQ pull-up resistor for NTC needs to be removed to
avoid conflict with the pull-up resistor on the daughter board.

I X10
100nF b Connectorto NTC

Figure 15 NTC thermistor configuration

3.1.6 Auxiliary power supply

The auxiliary power supply circuit adopts the quasi-resonant, fly-back controller ICE5QSAG and the CoolSiC™
1700 V SiC MOSFET IMBF170R1KOM1 in a TO-263-7 package. There are two secondary windings. One generates
18V DC and the other generates 7V DC. The 18 V DC is connected to the gate drivers. 3.3V power supply is derived
from the 7V DC using the linear regulator IFX25001ME V33. This 3.3V power supply is used in the overcurrent bias
circuit. Both 18 V and 3.3 V are also present at the 20-pin interface connector X8 on the daughter board. The
primary ground, and secondary +18 V and +3.3 V reference grounds are in a star ground connection on the main
board as shown in the schematic in Figure 18.
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3.2

Schematics

The schematics of EVAL-6ED2231S12TM1 are shown in Figure 16, Figure 17, and Figure 18.
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Circuitry of the power inverter board (mother board)

+3V3
R20 1k Z
2 D7 1 Vss
Red
vDC 2 1 C11
ITRIP__ 4 | ¢ 3 SHUNT- 10uF
GATEKILE 5 SHUNT+
veck 8 L |
7
) Vss:
PWMUH 1 C8
PWMUL _ 3 TTIOUF
PWMVH 5
PWMVL 7 i
PWMWH SHONT !
PWMWL SHUNT-
GATEKILL 4 VDC
ol
9 {vce
2.2uF
M1 Connector foriMotion
VSsS
+3V3 C12
100nP|'
VS§S
ConnectortoNTC

vee
106F
vss u
com—2{|22Ee2 1 vee vss 2
x12
RL 0k PWMUH _R24—{00R L ver [ G jjzae DL 2R 500&@—1 E—F 1
PWMUL 2] T Ml wenion K M 1
R3 0k RE—hooR vs1 [2V5T RELhk 2
X14
RS 0k PWMVH_RoG—o0R o gé g 226 00 g z%d 500413_1 E—F 2
" LIN2 HO2
R7 0k RT—ioR ver 2
RO 0k PWMWH R28—100R 3 18 220F 13 2RIG—1IR g
PWMWL 3 ['I'n; xgg ji H03 K - 1
RI—ok Ro—o0R O [Tevss R—5k 7
ITRIP :Ingz K ><1e
€6 {220t Tof mRip Lo1 2O 3%;{5004 5001 N
Bl 7
o e, GATEKILL 8 peey P s
s - 14108 D5 g
R16 Lo3 OReon |
+3v3
Vss 2MEG L1 ne com & Z
GED2231S 12T 16 2RIG—IOR ©
1
RT 1T ;
R30
L
-
<5 IR

COoM

Figure 17

User guide

Drive circuitry of the daughter board

22 0f 33

V11
2024-02-04



o~ _.
EVAL-6ED2231S12TM1 User Guide |nf|ne0n
1200 V SOl gate driver 6ED2231S12T evaluation board
System design

DC+ SS3H10HE3_A/H \CcC
1 TRL D1 T
3% e 10 2 Neo1 ]
B B p
22MEG 22 [e3 23 _l+ce _*cr
R2 MEG 22nFI1kV k T 330uF/25V T 330uF/25V
z . g 2 D2 1 <
c8 25 USIMHE3/61T  USIMHE3/61T
2.2MEG 26 22nF/1kV T 00k D3 D4 é MBRS1100T3G SGND_+18V/
R2 MEG 1 K« 2 1 K« 2 1 Gl __IFX25001TFV33+3V3
D N 6 -1 3 I
1D5 2 4 I 5 @
o) z 28
29MEG 29 MBRS1100T3G T 1000F l © K
R30 MEG - -
5 clolt+ cu cr I+ _lcis
22MEG 1D6|/1 2 % £ ZZOHFIIGVI Tmﬂ; 220uF/15\ﬂ' Il D7
RS %EG BA\'/l\IQWJ-F 30k §R9d
Lcu [ < SGND_+3V3
10nF/1kV 7R }QZ il
~ IMBF170R1KOM1
36 gi\/lg -1-F IEESQSAG
2% Tfvec  eate |2 it
- 4of 7c0  source |2 o
., 2of vIN cs fod w
&1 oo rB ok 4lc A
=Y - N2
~ []Rdl ~ SFH6L7A-3X00TT
62k 43 A4
H_ l+c2 20 Jor Jes | on c19 oo R
«I 4 i le" FTQUPFTMF 3 3nFT -Fiil)pF 4>—N|A I—D—'NA
T e
PGND TL431CDBZR
SGND_+18V
Figure 18 Auxiliary power supply circuitry
3.3 Layout
3.3.1 Layout details
Detailed layouts of the power inverter board and daughter board are shown in Figure 19 to Figure 22.
. M -
LI
EVAL-6ED2231S12TM1 iy !
REV 1.0 -lm-l
2022-03-16 - o
O O
Figure 19 Power inverter board layout (top view)
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Figure 20 Power inverter board layout (bottom view)
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Figure 21 Drive circuitry layout of the daughter board (top view)
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Figure 22 Drive circuitry layout of the daughter board (bottom view)

3.3.2 Layout guidelines
Some basic layout guidelines are as follows:
e TheVcc and Vs bypass capacitors should be close to the IC
e Thedrive loop should be as small as possible

e The loop of VSS and COM should be made as small as possible by connecting the VSS and COM directly
at the shunt-resistor terminals

e Thetwo current-sensing traces should be started from the shunt terminals and placed close to each other
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3.4

Bill of material

The complete bill of material (BOM) is available in the Downloads section of Infineon’s homepage. A login is
required to download this material.

Table 5 lists the important components used in EVAL-6ED2231S12TM1.

Table5 BOM of the most important/critical parts
No. Ref designator Description Manufacturer | Manufacturer P/N
1 Ul (daughter 1%00Vthree—phase gate-d.rlver Infineon ‘ 6ED2231S12T
board) with over-current-protection Technologies
EasyPACK 1B 1200 V six-pack Infineon
2 1 ther board . . . FS55MR12W1M1H_B11
Q1 (mother board) module with CoolSiC MOSFET Technologies -
3 U1l (mother board) | Quasi-resonant controller Infineon . ICE5QSAG
Technologies
4 02 (mother board) 1700 V/1 Q SiC MOSFET in TO263-7 | Infineon ‘ IMBE170R1KOM1
package Technologies
5 G1 (mother board) | > /400 mAlinearvoltage Infineon IFX25001TF V33
regulator Technologies
6 R1,R16, R17 30 mR /3 W SMD shunt resistor Viking CS25FTG:R0O30W
(mother board)
470 uF 450V i i
7 C1, C3 (mother O . 50V aluminum electrolytic Wiirth 861011486024
board) capacitor
0.47 pFfil itor - 1000V (1 kV
8 C2 (mother board) uF film capacitor - 1000V (LkV) | |\ v 890493427007CS
polyester, metallized radial
3.5 Connector details
Table6 Connectors
PIN Label Function
X1, X2, X3, X4, X5, X6, X7, X10 Daughter and mother board connections
DC+, DC- X8 (DC+/DC-, mother board) DC power supply input
u,v,w X9 (U/V/W) Three phaseouts (U/V/W) to the motor
X8 (daughter board) iMOTION™ MADK-M1 20-pin interface connector
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4 System performance

4.1 System setup for running a BLDC motor
EVAL-6ED2231S12TM1 is tested while running a BLDC motor in the setup shown in Figure 23.
Test conditions:
e Input:Viy=510VDC
e Phaseout current: lppase = 15 Arms
e Room temperature
e BLDC motor: GK6081-6AC31-FE, lpnase = 15 A, test at speed = 1450 r/min and 17 Nm

e Heat sink with natural ventilation for the six-pack module

— e
(nfineon_ ., f'ﬁ.
=\

/AL-6ED2231S12TM1 ||
Vi 1a

122-03-16

Figure 23 System setup for running a BLDC motor
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4,2 The output phase current

Figure 24 shows the waveform when running a BLDC motor.
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Figure 24 Phase U output current 15.7 A waveform at Viy=510V, P,y =3 kW, Fsw =12 kHz

4.3 Test result for over-current protection

Figure 25 shows the overcurrent detection function of EVAL-6ED2231S12TM1 by ITRIP input of 6ED2231S12T.
Overcurrent detection shuts down the outputs of the gate driver if the ITRIP pin input is over 500 mV and lasts
longer than 500 nanoseconds. In that case, the overcurrent protection starts when the peak current is around
25.2A.
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Figure 25 Overcurrent protection
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4.4 Test results for short-circuit protection

Figure 26 shows the short-circuit protection of EVAL-6ED2231S12TM1. The total short-circuit protection delay

time (including external RC filter, 1 kQ / 220 pF) is about 1 microsecond when the input voltage Viv is 600 V and
the maximum current is about 143 A.
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_ Trig?
€& 950.000ns 27.00 A CHl - LIN
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(@ 5.00V 2 & 200V ] @& 1004 ][1.00;15 ][S.UOGSISI } - - 2.50v}
)

@ Max 143 A 20M points
6 May 2022
12:10:12

Figure 26 Short-circuit protection at V,y= 600V

4.5 Inverter’s efficiency vs input power

Figure 27 shows the inverter’s efficiency vs different input powers at Vix=510V, lpuase = 11.2 A, Fsw = 16 kHz, and
T,=25°C.
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Figure 27 Inverter’s efficiency vs input power at Viy=510V, lpyase = 11.2 A, Fsw =16 kHz, T,=25 °C
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4.6 Inverter’s efficiency vs carrier frequency

Figure 28 shows the inverter efficiency vs different carrier frequencies at Vix=510V, lpuase = 11.2 A, P = 2 kW, and
T.=25°C.
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Figure 28 Inverter efficiency vs carrier frequency at Viy=510V, lpuase =11.2 A, Py =2 kW, T.=25°C
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5 References and appendices

5.1 Abbreviations and definitions

Table7 Abbreviations

Abbreviation Meaning

IC Integrated circuit

IGBT Insulated gate bipolar transistor
DC Direct current

AC Alternating current

BLDC Brushless direct current

SiC Silicon carbide

PWM Pulse width modulation

NTC Negative temperature coefficient
EVAL Evaluation board

PCB Printed circuit board

SOl Silicon oninsulator
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